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1. VMx5 HMI package installation 

1.1. Introduction 

The VMx5 HMI is the management software package of the modular multifunction VM25 and VM15 systems 
for machine tools. The application comprises: 

 The operator interface through which it is possible to monitor the correct evolution of the 
processes and functions enabled in the system (automatic balancing, touch detection, in-process 
measurement of the parts being machined). 

 A set of controls at the operator
’
s disposal for working with the system in manual mode 

 Parameter programming pages for both the system and each individual function so that the 
application can be completely customized. 

 A set of graphic libraries (OCX, ActiveX, DLL controls) so that display interfaces fully integrated 
into the host control can be created. 

This documentation concerns the installation and use of the VMx5 HMI package starting with version 12.0 

 
 

1.2. Installation package 

The VMx5 HMI is supplied in a package with the following part number: 

9HMVMX5xxUSWP0 – VMx5 HMI package with USB 2.0 interface 

where “xx” = indicates the software version  

The kit supplied includes: 

 USB flash drive containing VMx5 HMI and VMx5 Service software with documentation 
 USB/BsLink serial converter with drivers for OS ®Windows 

The cable to connect the VMx5 control unit to the PC is supplied separately, depending on the required 
length. 

 

1.3. System requirements 

Minimum requirements of the host PC: 

 Pentium IV – 1,2 GHz processor or equivalent 
 1 Gb Ram (2 Gb recommended) 
 200 MB Hard Disk free 
 VGA graphic card with minimum resolution 640x480 (SVGA 1024x768 recommended) 
 1 x USB 2.0 port free 
 TCP/IP protocol installed 
 Operating system 

 XP SP2 
 Vista 
 W7 
 W8, 8.1 
 W10 

 Additional operating system requirements:  
 Windows installer 3.1 
 Framework .NET 2.0 or 3.5 (depends on release version) 
 Microsoft InteropForm Redistributable Package 2.0 

 Other requirements may be necessary on dedicated platforms 
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1.4. Installation 

 

1.4.1. Installation of the USB-BsLink serial converter driver  

The USB-BsLink serial converter comes with a kit including: 

 USB-BsLink hardware converter (p/n 9CSUSB23003000) 
 USB extension cable 
 USB flash drive containing driver and user documentation 

 

 
 
To install the driver: 
 

 Insert the USB flash drive containing driver into the USB port of the PC 
 Insert the converter into the USB port of the PC 
 Wait for the device to be recognised and follow the instructions 

 
Note: refer to the documentation provided in the installation USB flash drive for detailed information 
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1.4.2. VMx5 HMI installation on a stand-alone PC 

 
The procedure will install the following components: 
 

 VMx5 HMI application 
 Auxiliary Windows components (if necessary) 

 

1.4.2.1. Procedure 

To install the VMx5 HMI package, plug in the USB flash drive into the USB port of the PC: 

 Click on Start in Windows, select Run…  

 Enter < Drive>:\HMI v120.yymmdd\Setup.exe (where: < Drive>  is the USB flash drive). 
 Continue by following the instruction. 

 

 
 

 Read carefully the general conditions of the license for the use of the software and accept them. 
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 Select the “Generic PC” option 
 

 
 

 Select the folder where setup will install files. The default path is C:\BalanceSystems\ 
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 Continue by following the instructions 
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NOTE 

 Previous versions of the VMx5 HMI package should be removed before proceeding with the new 
installation. 

 
 

 The setup software will allow the user to uninstall previous VMx5 HMI package versions. 
 

  
 

 To maintain previous VMx5 HMI configuration parameters, select “Yes”. 
 

 
 

 As an alternative, follow the standard Windows procedures to remove any previous installations 
of the VMx5 HMI. 

 
 Click on Start in Windows, select Settings and Control Panel 
 Double click on Add/Remove Software 
 Select VMx5 HMI and click on Remove 

 
 When the uninstall procedure is completed, run the setup procedure again and follow the 

instructions. 
 

 
 

1.4.2.2. Folder organization 

Structure of the folders after installing in “C:\” 
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Name Description 

BalanceSystems OEM folder 

VM15 VM15 System folder 

HMI VMx5 HMI application 

v120 Version 12.0 folder 

Bin System and Graphic Library files 

DataRec Data recording storage folder 

Doc User documentation  

Res Resources (e.g. Languages) 

Samples Examples for integrating the graphic library 

Scada Communication layer application 
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1.4.3. VMx5 HMI Installation on machine control 
®
Siemens PCU 

 
The procedure will install the following components: 
 

 VMx5 HMI application 
 Auxiliary Windows components (if necessary) 

 
 

1.4.3.1. Procedure 

 

Start the 
®
Siemens PCU in WINDOWS mode: 

 Turn on the PCU 
 During the start phase, press “3” as soon as the white screen with the version indicated in the 

lower right-hand corner appears 
 Enter user ID: “auduser” 
 Enter the manufacturer’s password 
 Press ENTER 

 

To install the VMx5 HMI: 

 

 Click on Start in Windows, select Run… 

 Enter <Drive>:\HMI v120.yymmdd\Setup.exe where: < Drive>  is the USB flash drive). 
 Continue by following the instruction 
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 Read carefully the general conditions of the license for the use of the software and accept them. 
 

 

 
 Select the target of installation:  

- ”PCU Siemens HMI Advanced (Windows XP)” 
- ”PCU Siemens Sinumerik Operate (Windows XP)” 
- ”PCU Siemens Sinumerik Operate (Windows 7)” 
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 Choose the destination folder: 
 

 

 
 

FOLDER 
ADVANCED for Windows XP  

FOLDER PATH 

ADDON F:\add_on\BalanceSystems\ 

OEM F:\oem\BalanceSystems\ 

USER F:\user\BalanceSystems\ 

 

FOLDER 
OPERATE for Windows XP  

FOLDER PATH 

ADDON F\hmisl\addon\sinumerik\hmi\BalanceSystems\ 

OEM F:\hmisl\oem\sinumerik\hmi\BalanceSystems\ 

USER F:\hmisl\user\sinumerik\hmi\BalanceSystems\ 

 

FOLDER 
OPERATE for Windows 7 

FOLDER PATH 

ADDON C:\... \MotionControl\addon\BalanceSystems 

OEM C:\... \MotionControl\oem\BalanceSystems 

USER C:\... \MotionControl\user\BalanceSystems 
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NOTE: OEM level is default selected 
 

 

IMPORTANT: from the selected level depends the view of the installed applications.  
The applications installed at highest levels can influence the ones installed at lower levels. 
See below the scale of importance of the available levels: 
 

- OEM : Higher level 

- ADDON : Intermediate level 

- USER : Lower level 
 
The installer has to make sure that the installation level will not be in conflict to the already installed 
application levels. 

 

NOTE: on “Siemens Operate” for both Windows XP and Windows 7, the installer can select the ID 
number process (Default value 600). If not choosen by the installer, the system will re-address ID to 
another value, pending by the already installed applications.  
  

NOTE: the selection of the softkey (default value 7) has to be taken according to the available space on 
the Siemens HMI keyboard. See paragraph 1.4.3.4. 

 
 

 Continue by following the instruction 
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NOTE 

 Previous versions of the VMx5 HMI package should be removed before proceeding with the new 
installation. 

 
 The setup software will allow the user to uninstall previous VMx5 HMI package versions. 

 

   

 
 To maintain previous VMx5 HMI configuration parameters, select “Yes”. 

 

 
 

 As an alternative, follow the standard Windows procedures to remove any previous installations 
of the VMx5 HMI. 

 
 Click on Start in Windows, select Settings and Control Panel 
 Double click on Add/Remove Software 
 Select VMx5 HMI and click on Remove 

 
 When the uninstall procedure is completed, run the setup procedure again and follow the 

instruction. 
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1.4.3.2. Folder organization 

 

Structure of the folders after installing in 
“
F:\...\BalanceSystems\...

”
 

 

 
 
 

Name Description 

BalanceSystems OEM folder 

VM15 VM15 System folder 

HMI VMx5 HMI application 

v120 Version 12.0 folder 

Bin System and Graphic Library files 

DataRec Data recording storage folder 

Doc User documentation  

Res Resources (e.g. Languages) 

Samples Examples for integrating the graphic library 

Scada Communication layer application 
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1.4.3.3. Integrating VMx5 HMI inside 
®
Siemens HMI – Sinumerik Advanced 

The VMx5 HMI application can be started directly in the 
®
Siemens HMI – Sinumerik Advanced by assigning a 

special softkey. 

 Enter the following instructions in the TaskConfiguration section of file F:\Add_on\Regie.ini to 
associate for instance starting VMx5 HMI with the horizontal softkey “7” 

 
[TaskConfiguration] 
Task7 =  
name :=OEMFrame,  
CmdLine:=“F:\\Add_on\\BalanceSystems\\VM15\\HMI\\v120\\BSVM15HMI.exe -hosted”,  
ClassName :=““,  
WindowName :=“BSVM15 HMI”,  
Timeout :=20000,  
Preload :=False 
 

 Enter the following instructions in the 
“
HSoftkeyTexts

”
 section of the file F:\ Add_on\ Language\ 

RE_en.ini (and in all those of the recognised languages) 
 
[Hsoftkey Texts] 
HSK7 = “VM15 HMI” 

 

 In some 
®
Siemens HMI version it is also necessary to add the following section in the file 

F:\Add_on\OemFrame.ini 
 
[BSVM25HMI] 
nSwitchToTaskAfterTermination=-2 
nInitShowMode=3 
nShowMode=3 
fforcetaskfocus=1 

 
In this way the application will always be at the operator

’
s disposal and will be closed only when the 

®
Siemens 

HMI is closed. 
 
 

NOTE 
 
The templates for Regie.ini, Re_xx.ini and OemFrame.ini are supplied as text file in the following installation 
path: 
 

F:\Add_on\BalanceSystems\VM15\HMI\v120\Samples\Siemens\Add_on\Regie.txt 
F:\Add_on\BalanceSystems\VM15\HMI\v120\Samples\Siemens\Add_on\Language\Re_xx.txt 
F:\Add_on\BalanceSystems\VM15\HMI\v120\Samples\Siemens\Add_on\OemFrame.txt 

 
To complete the installation on Siemens HMI follow this procedure: 
 
Regie.ini 

 Open the text file Regie.txt 
 Open to edit the ini file F:\Add_on\Regie.ini, if this file does not exists, create it. 

 Copy the complete contents of the [TaskConfiguration] section from Regie.txt to 
F:\Add_on\Regie.ini file 

 Assign the desired Task number (i.e. Task7, as shown in the example above) 
 Save the updated F:\Add_on\Regie.ini file 

 

Re_xx.ini 
For each user language: 
 Open the text file Re_xx.txt 
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 Open to edit the language file F:\Add_on\Language\Re_xx.ini, if this file does not exist, create it. 

 Copy the complete contents of the [Hsoftkey Texts] section from Re_xx.txt to 
F:\Add_on\Language\Re_xx.ini file 

 Assign the same softkey number reserved in the Regie.ini file (i.e. HSK7, as shown in the example 
above) 

 Save all the updated F:\Add_on\Language\Re_xx.ini file 
 

OemFrame.ini 

 
 Open the text file OemFrame.txt 
 Open to edit the ini file F:\Add_on\OemFrame.ini,  

o if this file does not exist, copy OemFrame.txt as OemFrame.ini in the F:\Add_on folder. 

o if the file already exists copy the complete contents of the [BSVM15HMI] section from 
OemFrame.txt to F:\Add_on\ OemFrame.ini file. 

 Save the updated F:\Add_on\ OemFrame.ini file 
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1.4.3.4. Integrating VMx5 HMI inside 
®
Siemens HMI sl – Sinumerik Operate 

The VMx5 HMI application can be started directly in the 
®
Siemens HMI sl – Sinumerik Operate by assigning a 

special softkey. 
 

The VMx5 HMI installation package will provide for the complete integration of the configuration files 
assigning the horizontal softkey No. 7 by default. 
 
In case of different customization, follow the instruction below. 
 
  

Activating 
 

Proceed as follows to enable the Service Desktop: 
 
 

1. As soon as (1) is displayed under the version number on the bottom right of the startup screen, press 
the key “3”.  

 

 
 

Display during startup of the SINUMERIK 840Di sl 
 

2. Enter the manufacturer password 

3. Click the “Service Desktop” button in the displayed selection menu or press the “Return” key  
 
 

Integrating VMx5 HMI application into HMI sl 
 

Generally, applications are selected using a softkey in the area switchover bar.  The operating software is 
started and controlled from an application called System Manager. This System Manager also handles the 
control of the OEMFrame applications.  
The System Manager is configured using the “systemconfiguration.ini” configuration file. 
Below the example for the configuration procedure. 

NOTE: the folder can vary pending by the selection made (see paragraph 1.4.3.1). 
 

a. Creating a configuration file systemconfiguration.ini 
 

Open folder:   F:\hmisl\addon\sinumerik\hmi\cfg  
 

Edit:   systemconfiguration.ini 
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b. Contents of systemconfiguration.ini (Siemens Operate for Windows XP) 
 

[processes] 

PROC600=process:=BSVM25HMISYS, 

cmdline:=“f:\hmisl\addon\sinumerik\hmi\BalanceSystems\.. 

..\VM15\HMI\V120\BSVM25HMI.exe -hosted”, oemframe:=true, deferred:=true, 

windowname:=“BSVMx HMI” 

 

[areas] 

AREA600= name:=BSVM25HMI, process:=BSVM25HMISYS, panel:=SlHdStdHeaderPanel 

 

Contents of systemconfiguration.ini (Siemens Operate for Windows 7) 
 

[processes] 

PROC600=process:=BSVMxHMISYS, 

cmdline:=“c:\ProgramData\Siemens\MotionControl\oem\BalanceSystems\VM25\HMI

\V120\BSVM25HMI.exe –hosted”, oemframe:=true, deferred:=true, 

windowname:=“BSVM25 HMI” 

 

[areas] 

AREA600= name:=BSVM25HMI, process:=BSVM25HMISYS, 

 
c. Configuring additional settings 

 
In order to configure the following settings, you require the “slamconfig.ini” configuration file: 

 
 Assigning the softkey position of a specific operating area  
 Creating foreign-language text  
 Displaying icons for the operating area on the softkey  

 
 

d. Creating a configuration file slamconfig.ini (for Windows XP) 
 

Open folder:   F:\hmisl\addon\sinumerik\hmi\cfg  
 

Edit:   slamconfig.ini 

 

Creating a configuration file slamconfig.ini (for Windows 7) 
 

Open folder:   C:\Programdata\Siemens\Motioncontrol\Sinumerik\hmi\oem\cfg 
 

Edit:   slamconfig.ini 
 

e. Contents of slamconfig.ini 
 

[BSVMxHMI]  

TextId = VMx HMI  

Picture = BSVMxHMI.png  

SoftkeyPosition = 7  

 
 

f. Copy language files in F:\hmisl/addon/sinumerik/hmi//lng (Windows XP only) 
 

g. Copy picture file in F:\hmisl/addon/sinumerik/hmi/ico/icoXXX (for Windows XP) 

Copy picture file in C:\Programdata\Siemens\MotionControl\Sinumerik\oem\hmi\ico (for 

Windows 7) 
 

NOTE 
For further information refer to the document:  
“Embedding Solution Partner applications in SINUMERIK Operate.pdf” 
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1.4.4. VMx5 HMI Installation on machine control 
®
GE Fanuc PC  

 

1.4.4.1. Procedure 

 
The procedure will install the following components: 
 

 VMx5 HMI application 
 Auxiliary Windows components (if necessary) 

To install the package on Machine Control 
®
GE Fanuc with O.S. 

®
Microsoft Windows XP Embedded, it is 

required the utility Framework .NET 2.0 in full format. To proceed with the correct installation, follow the 
procedure (read additional information in <CD>:\VM15 HMI\Utility\NET Fw Cleanup Tool\User Guide.htm) 

 Launch the tool  <Drive>:\VM15 HMI\Utility\NET Fw Cleanup Tool\cleanup_tool.exe 
 Follow the procedure below 

 

To install the VMx5 HMI package, put the USB flash drive  into the port of the PC: 

 Click on Start in Windows, select Run…  

 Enter <Drive>:\HMI v120.yymmdd\Setup.exe (where: <CD> is the USB flash drive 
 Continue by following the instruction. 
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 Read carefully the general conditions of the license for the use of the software and accept them. 

 
 

 Select the “PC 
®
GE Fanuc” option 
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 Select the folder where setup will install files. The default path is D:\BalanceSystems\  
 
 

D:\BalanceSystems\

 
 

 Continue by following the instructions 
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NOTE 

 Previous versions of the VMx5 HMI package should be removed before proceeding with the new 
installation. 

 
 The setup software will allow the user to uninstall previous VMx5 HMI package versions. 

 

   

 
 To maintain previous VMx5 HMI configuration parameters, select “Yes”. 

 

 
 

 As an alternative, follow the standard Windows procedures to remove any previous installations 
of the VMx5 HMI. 

 
 Click on Start in Windows, select Settings and Control Panel 
 Double click on Add/Remove Software 
 Select VMx5 HMI and click on Remove 

 
 When the uninstall procedure is completed, run the setup procedure again and follow the 

instruction. 
 

 
 

1.4.4.2. Folder organization 

Structure of the folders after installing in “D:\” 
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Name Description 

BalanceSystems OEM folder 

VMx5 VMx5 System folder 

HMI VMx5 HMI application 

v120 Version 12.0 folder 

Bin System and Graphic Library files 

DataRec Data recording storage folder 

Doc User documentation  

Res Resources (e.g. Languages) 

Samples Examples for integrating the graphic library 

Scada Communication layer application 

 
 
 
 
 
 
 
 
 

1.4.5. Hardware connections 

 
To start the application it is necessary to connect to the rack of the VMx5 system through a serial connection 
(see figure), following this sequence: 
 
 Connect the remote cable on the VMx5 rack side (P1 connector) 
 Connect the serial converter to the other end of the cable 
 Turn on the VMx5 rack 
 Connect the serial converter to the USB port of the PC 
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2. Configuring the VMx5 HMI application 
 

The installation procedure ends by creating a desktop link to start the VMx5 HMI application. 
 
To be able to correctly use the VMx5 HMI application, it is necessary to configure some parameters. 

 Make sure that the VMx5 rack is on and connected to the PC 
 Start the VMx5 HMI application 

 

 
 

 
 
 

At the first start-up it is necessary to configure: 

 User language 
 COMx / USB connection port 
 IP address for remote operation (if used) 
 VMx5 system configuration 
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Select the Parameter command  [Shift+F7] to choose the configuration menu 
 

System commands 

Icon  ID 
Command 

Name 
Button Description 

 

0001 Exit HMI Shift+F1 Close the VMx5 HMI 

 

0010 Page Change  Shift+F2 Switch between the installed devices 

 

0095 Viewer page Shift+F3 It displays last opened viewer page 

 

0011 Print Shift+F4 Print the displayed screen 

 

0013 
Parameters 
settings 

Shift+F7 Access parameter management for system configuration 

 

0005 Login F5 Access login levels management  
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2.1. Language configuration 

 

 Select the tab Language to choose the user language 
 

 
 

System commands 

Icon  ID 
Command 

Name 
Button Description 

 

0095 Viewer page Shift+F3 It displays last opened viewer page 

 

0011 Print Shift+F4 Print the displayed screen 

 

0017 Exit Shift+F8 Exit & save the configuration 

 

Parameter Description 

Remote change language 

 

[check box]. When activated, it is possible to automatically 
manage the language by profibus or profinet (acyclic data). 
Further informations about language CN table are described on 
“9UMEN1507-1100 YYMMDD Remote Programming v120 En.pdf” 
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2.2. Connection configuration 

 

 Select the tab Connection  to configure the VMx5 communication ports 
 

 
 
 

System commands 

Icon  ID 
Command 

Name 
Button Description 

 

0095 Viewer page Shift+F3 It displays last opened viewer page 

 

0011 Print Shift+F4 Print the displayed screen 

 

0017 Exit Shift+F8 Exit & save the configuration 
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2.2.1. COMx port for rack connection 

 
 
If the PC is directly connected to the VMx5 rack via USB port, set the parameters in the 

“
Serial port 

configuration
”
 box. 

 
 

Parameter Description 

COM Port 

[COM1] 

Com port number 

COM1, COM2, ...., COM16  

Baud rate [bps] 

[115200] 

Com port baud rate 

9600, 19200, 38400, 57600, 115200 

 
 

2.2.2. IP address for remote operation 

 
 
In the case of remote connection via Ethernet TCP/IP to another VMx5 HMI or VMx5, set the parameters in 
the “TCP/IP configuration

”
 box 

 
 

Parameter Description 

Host address  

[localhost] 

IP address of the device to which the VMx5 rack is physically 
connected.  

Example: 192.168.1.62 

Host port 

[4000] 

Number of the Ethernet port.  

Example: 4000 

Manual managing of the 

communication layer 

 

[check box]. When activated, the communication task with the 
VMx5 rack is manually managed by the installer. This feature is 
reserved for special applications guided by Balance Systems 

HMI Id 

[1] 

Address of the actual VMx5 HMI instance in the VMx5 system 
(values from 1 to 49) 

Should be used when more than one VMx5 HMI or VMx5 Control 
Panel are connected to the same system. 

Setting “0” the address is automatically assigned (values from 50 
to 127) 

 
 

2.2.3. CPU preferences  

 

Parameter Description 

Priority 

[Normal] 

It sets execution priority of VMx5 HMI process into the operating 
system. 

Affinity 

[All processors] 

Related to system resources, it allows to define CPU which have 
to be used by VMx5 HMI 

Graphic control sampling [ms] 

[20] 
It defines HMI sampling time 
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2.3. VMx5 system configuration [Devices] 

 

 Select the “Devices” tab to define the VMx5 system configuration 
 
 Enable the devices. In the example: Balancer 1, Touch Detector 1  

 
Note: to optimise the test phase when the system is turned on, enable only the devices actually installed in the 
system 

 
 
 

System commands 

Icon  ID 
Command 

Name 
Button Description 

 

0095 Viewer page Shift+F3 It displays last opened viewer page 

 

0011 Print Shift+F4 Print the displayed screen 

 

0017 Exit Shift+F8 Exit & save the configuration 
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2.4. Connection and devices recognition 

 
Once the operations described in the previous paragraphs have been completed, it is possible to start the 

connection procedure for devices recognition using the Connect command   [F1].  
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System commands 

Icon  ID 
Command 

Name 
Button Description 

 

0001 Exit HMI Shift+F1 Close the VMx5 HMI 

 

0010 Change Page Shift+F2 Switch between the installed devices 

 

0095 Viewer page Shift+F3 It displays last opened viewer page 

 

0011 Print Shift+F4 Print the displayed screen 

 

0013 Parameters Shift+F7 Access parameter management for systems configuration 

 

0002 Connect F1 
Start the connection procedure between the VMx5 HMI 
interface and the VMx5 rack 

 

0003 Disconnect F2 
Stop the communication between the VMx5 HMI interface 
and the VMx5 rack 

 

0004 Service F3 Switch to “service” mode for mainteniance operations 

 

0005 Login F5 Access login levels management  
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3. Programming and Setup 
 

3.1. Introduction 

This chapter is devoted to describing configuration parameters regarding the VMx5 HMI application. 
 

Before proceeding to set the parameters, it is necessary to verify the following conditions: 

 The hardware of every card must be properly configured 
 Every card must be able to support all of the required options 

 Every card must be properly housed in the VMx5 rack 

 The VMx5 HMI application must be enabled for controlling every card installed 

 
Note: All of the configurable parameters will be described. Some of them, or entire selections, might not be 
available on the system being used, depending on the hardware and software configurations of the cards 
installed. 

Typical work flow for starting and configuring the system: 

1. Access to the system settings 

2. Language setting 

3. Connection parameter setting 

4. Setting the system configuration (installed devices) 

5. Setting of the login access level 
6. Setting the VMx5 HMI interface layout 

7. Setting of each installed device 

8. Backup execution 
 
 

NOTE 
 
For the description of the setup parameters of each installed device refer to the document present at the link 
Parameter setup  
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3.2. HMI system settings 

After the VMx5 HMI application has been installed, press the command HMI  [Shift+F1] to access 
to the system settings. 
 
 

 
The following areas are identified on the screen: 
 

A. Header 

B. Horizontal control bar associated with the keys [Fx] 

C. Vertical control bar associated with the keys [Shift+Fx] 
D. System connection configuration summary  
E. List of installed devices: 

 Device name 

 Software version 

 Memory version 
 
 
 
 

C 

E 

D 

A 

B 
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The commands available are summarized in the following table 
 

System commands 

Icon  ID 
Command 

Name 
Button Description 

 

0001 Exit HMI Shift+F1 Close the VMx5 HMI 

 

0010 Change Page Shift+F2 Switch between the installed devices 

 

0095 Viewer page Shift+F3 It displays last opened viewer page 

 

0011 Print Shift+F4 Print the displayed screen 

 

0013 Parameters Shift+F7 Access parameter management for systems configuration 

 

0002 Connect F1 
Start the connection procedure between the VMx5 HMI 
interface and the VMx5 rack 

 

0003 Disconnect F2 
Stop the communication between the VMx5 HMI interface 
and the VMx5 rack 

 

0004 Service F3 Switch to “service” mode for mainteniance operations 

 

0005 Login F5 Access login levels management  
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3.2.1. Setting the Access Level [Login] 

 
The VMx5 system is equipped with a login system, managed via enabling password that allows access for 
use according to 4 different hierarchical levels. In addition to enabling the use of particular functions, each 
level allows the use of the functions of all lower levels. 

The following factory-set passwords are difined for the different access levels: 
 
 
 

Level Password Description 

Observer 1 
All the enabled devicecs operate automatically without any possibility of 
intervention. The only active functions allow the display to be shifted over to 
various devices and to change the access level 

Operator 1 2 9 4 
All of the enabled devices operate automatically with the possibility of 
accessing the correction functions (see detailed information on the individual 
device) 

Programmer 1 4 3 2 
Every VMx5 system device can operate both automatically and manually with 
access to the working parameters of each device (see detailed information on 
the individual device) 

Installer 1 2 2 1 

Every VMx5 system device can operate both automatically and manually with 
access to the Setup menu of the entire system. 
This level is reserved for the technical personnel specialized in installing the 
VMx5 system 

 
 
 
It is possible for the user to define their own customised passwords, and to restore the factory default 
passwords. 

To access the access level management, use the Login command  [F5] 
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3.2.1.1. Login change 

 Select the new access level (use the mouse or the direction arrows) 

 Enter the password relative to the new level and press Confirm   [F2] 

 
 

 
 

System commands 

Icon  ID 
Command 

name 
Button Description 

 
0011 Print Shift+F4 Print the displayed screen 

 

0015 Confirm F2 Activate the new access level 

 

0006 
Change 
password 

F3 Allow the password to be changed 

 

0042 Reset F5 Restore the factory passwords 

 

0017 Exit Shift+F8 Exit & save the configuration 
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3.2.1.2. Password modification 

 
All of the passwords can be modified as follows: 

 

 Press Change password   [F3] 
 Enter the password of the level you want to modify 
 Enter the new password 
 Enter the new password again 

 Press Confirm   [F2]  to save the new password 
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3.2.1.3. Restoring the factory password 

 

 Access with  Installer login 

 Press   [F5] 
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3.2.2. Customization of the VMx5 HMI interface layout [Layout] 

 
The VMx5 HMI interface is designed to adapt to the host. This means that is why the user can select a set of 
layouts (number of commands and their positions, header sizes, etc.) in addition to having the possibility to 
create a completely personalized layout. 
 

To select the desired layout, use the Parameters command  [Shift+F7] 
 

 Select the Layout tab 
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In the “Settings” box 
 

Parameter Description 

Header height 

[70] 

Space set aside for the header, in number of pixels The 
application does not occupy this area, and it is often assigned 
to, for example, other applications e.g. Siemens HMI. 

Color palette 

[0] 
Select one of the options to define the colour palette. 

Layout 

[Custom] 

A set of default layouts already designed for typical applications 
is available 

PCU50 
®
Siemens 

PC 
®
GE Fanuc 

 
Otherwise, a personalised layout can be defined. 

Custom: the parameters in the “Actual configuration” box are 
enabled. 

Width 

[800] 
VMx5 HMI form width (pixels) 

Height 

[600] 
VMx5 HMI form height (pixels) 

X position 

[50] 
Horizontal position in pixels. 0 = left side 

Y position 

[0] 
Vertical position in pixels. 0 = top side 

Full screen 

 

[Check box] If selected, the VMx5 HMI form will take the full 
sceen 

Fix Size 

 
It Allows to lock the window with a default size 

Fix Location 

 
It Allows to lock the window in a default position 

Window Border 

 
Shows the classic Windows view 

Tooltips 

 
Shows the helpful tooltips for commands and states 

Smart change page (*) 

 
Enables smart change page 

Quick shortcut 

[drop-down menu] 

It allows to choose page quick shortcut in the smart change 
page (favorites or recent) 

Start HMI page 

 

Enabling the check box, the HMI will display the page indicated 
in the below drop down menu at the start-up. 

Use last page (HMI) 

 

Enabling the check box, at the start-up, the HMI will display the 
last shown page. 

Start VIEWER page 

 

Enabling the check box, the viewer will display the page 
indicated in the below drop down menu at the start-up. 

Use last page (VIEWER) 

 

Enabling the check box, at the start-up, the viewer will display 
the last shown page. 
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Parameter Description 

Viewer Designer 

 

Enable Viewer feature and allows to enter in Viewer settings 

page  

 

(*) Smart change page allows to directly choose the page to display avoiding to continuously press Change 

page  [Shift+F2] to reach desired page.  
 
Recent / favorites menu is also available. 
Left-click on desired page, allows to open the page.  
Right-click on desired page allows to customize the name of the page. 
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In the “Keyboard” box 
 

 
 
 
 

Parameter Description 

Top Margin 

[10] 

Position associated with the command bar on the side (in 
pixels, starting from the top) 

Side Bar: Button height 

[59] 
Height of the button (in pixels) 

Side Bar: Button width 

[59] 
Width of the button (in pixels) 

Vertical spacing 

[1] 
Distance (pixels) between two adjacent button 

Number of buttons 

[8] 
Number of buttons of the side command bar 

 
 
 
 
 
 
 
 
 



Release: 220128 
  9UMENX519-1200 

  VMX5 HMI – INSTALLER 
 

 
 

3-45 

Parameter Description 

Left Margin 

[8] 

Position associated with the command bar on the bottom 
(in pixels, starting from the top) 

Bottom bar: Button width 

[90] 
Width of the buttons (pixels) 

Bottom bar: Button height 

[50] 
height of the buttons (pixels) 

Horizontal spacing 

[1] 
Distance (pixels) between two adjacent buttons 

Number of buttons 

[8] 
Number of buttons of the bottom command bar 

 
 
 

Loading management

 
 
 
 
 
 
 
 
 
 
 
 
 



Release: 220128 
  9UMENX519-1200 

  VMX5 HMI – INSTALLER 
 

 
 

3-46 

In the “Icons” box 
 

Parameter Description 

Command icons size Sets the size of Command icons 

State icons size Sets the size of State icons 

Active command icons color Changes color of active icons Command 

Inactive command icons color Changes color of inactive icons Command 

State icons color Change the color for status icons 

Quality Choice between two levels of graphic quality 

Loading management 

It defines HMI icons management: 

Standard: all the icons are loaded during HMI start up in 
background. Connection or others operations are available 
during icons loading.  

Slow: all the icons are loaded before HMI start up. 
Connection or others operations are not available during 
icons loading. 

 

System commands 

Icon  ID 
Command 

Name 
Button Description 

 
0011 Print Shift+F4 Print the displayed screen 

 

0017 Exit Shift+F8 Exit & save the configuration 

 
 

 
 



Release: 220128 
  9UMENX519-1200 

  VMX5 HMI – INSTALLER 
 

 
 

3-47 

 
 
 
 
In the “Color” box 
 

System commands 

Icon  ID 
Command 

Name 
Button Description 

 
0011 Print Shift+F4 Print the displayed screen 

 

0017 Exit Shift+F8 Exit & save the configuration 

 

0026 
Factory color 
palette 

F4 Sets the factory colors palette 

 

0023 Data loading F3 Loads the color configuration 

 

0024 Data save F2 Save the color configuration 
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3.2.2.1. Viewer settings 

Viewer feature allows to create customizable pages (up to 16) in order to show VMx5 function pages 
(balancer, touch detection, gauge) on the PC or NCU screen (as a pop-up) to monitor all the processes 
independently from NCU main sowtware. 
Each page, once created, can be recalled and displayed with Profibus or Profinet  asynchronous commands. 
 

 
In order to access to Viewer settings follow nexts steps: 
 

 
 
 
In the layout page, check  “View Designer”  

checkbox and click on button. 
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Settings page will be appear on the screen as follow: 
 

 
 

Viewer settings (“Home” tab) 

Icon  ID Setting Name Button Description 

 

 Exit  Exit  

 

 Save  Save viewer pages settings 

 

 Page List  Shows all viewer pages with their ID 

 

 Control List  It lists all the objects included in the selected page 

 

 
Temp 
background 

 

Allows to temporary import an image file (“.bpm” “.png” “.tiff” 
“.jpg”) to use as page background.  

This setting helps the installer to define the correct position 
of the page on the screen. 

Make sure to disable “Trasparent background” checkbox in 
DESIGN drop-down menu.  

 

 New page  It adds new page to the list (up to 16). 

 

 Delete page  It deletes selected page 

 

 Import page  It allows to import page configuration file (“.bpg”) 

 

 Export page  
It allows to save configured page as “.bpg” file in order to 
import the same page on different machine 

  
Hide pages 
hotkey 

 It defines hotkey to hide viewer pages 

  
Registered 
hotkeys 

 

Shows registered hotkeys list 

  

 

 

 

No top most 

 

Top most 

 Defines if the page has to be showed always on top or not 

 

 

 

Connect 

 

Disconnect 

 
Allows temporary connection to the system to show how 
configured page works. During the connection is not 
possible to apply any page modification 
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Viewer settings (“Home” tab) 

Icon  ID Setting Name Button Description 

 

 Undo  Undo last modification (Ctrl + Z) 

 

 Redo  Redo last modification (Ctrl + R) 

 

 Delete  It deletes selected object (Canc) 

 

 Copy  
It copies selected object on the same or on another page 
(Ctrl + C) 

 

 Cut  
It cuts selected object on the same or on another page  

(Ctrl + X) 

 

 Paste  
It pastes copied or cutted object on the same or on another 
page (Ctrl + V) 

 

 
Size and 
position 

 
Allows to define height, width and position of selected 
object (control, command, label or panel). Size and position 
modification it is also possible using the mouse. 

 

 

 

Unlock position 

 

Lock position 

 
Unlock / Lock the position of the selected object on the 
screen 

  Help  

Shows hotkeys list for operations: copy, paste, cut, undo, 
redo, show menu. 
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In the table below, all the controls and available commands are listed. Follow the steps indicated in the next 
section to perform the association between: 

- Controls and function card (and section) 

- Commands and controls 
 

 
 

Viewer settings (“Controls” tab) 

Icon  ID 

Control / 

Command 

Name 

Button Description 

 

 BN 1 plane full  

Allows to import balancer 1 plane full control in the selected 
page 

Unbalance vector, rpm value and weights movemet 
indicators will be displayed. 

Tollerances will be related to selected part program. 

Follow the instructions given in the BALANCER “Design” 
tab to configure the control. 

 

 
BN 1 plane 
compact 

 

Allows to import balancer 1 plane compact control in the 
selected page. Unbalance and rpm value will be displayed. 

Follow the instructions given in the BALANCER “Design” 
tab to configure the control. 

 

 TD full  

Allows to import touch detector full control in the selected 
page 

Variables and limit related to selected part program will be 
shown. 

Follow the instructions given in the TOUCH DETECTOR 
“Design” tab to configure the control. 

 

 TD compact  

Allows to import touch detector compact control in the 
selected page 

Variables values related to selected part program will be 
shown. 

Follow the instructions given in the TOUCH DETECTOR 
“Design” tab to configure the control. 
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Viewer settings (“Controls” tab) 

Icon  ID 

Control / 

Command 

Name 

Button Description 

 

 TD command  

Allows to import touch detector commands object in the 
selected page 

Limits modification will be available on selected part 
program 

Follow the instructions given in the TOUCH DETECTOR 
“Design” tab to configure the command. 

 

 AG full  

Allows to import AG full control in the selected page. 

Measured value, limits and offset related to selected part 
program will be shown. 

Follow the instructions given in the GAUGE “Design” tab to 
configure the control. 

 

 AG compact  

Allows to import AG compact control in the selected page. 

Measured value related to selected part program will be 
shown. 

Follow the instructions given in the GAUGE “Design” tab to 
configure the control. 

 

 AG zero  

Allows to import AG zero control in the selected page. 

Follow the instructions given in the GAUGE “Design” tab to 
configure the control. 

 

 AG command  

Allows to import AG commands in the selected page 

Offset correction will be available on selected part program. 

Follow the instructions given in the GAUGE “Design” tab to 
configure the command. 

 

 NG full  

Allows to import NG full control in the selected page. 

Measured value, limits and offset related to selected part 
program will be shown. 

Follow the instructions given given in the GAUGE “Design” 
tab to configure the control. 

 

 NG compact  

Allows to import NG compact control in the selected page. 

Measured value related to selected part program will be 
shown. 

Follow the instructions given in the GAUGE “Design” tab to 
configure the control. 

 

 NG zero  

Allows to import NG zero control in the selected page. 

Follow the instructions given in the GAUGE “Design” tab to 
configure the control. 

 

 NG command  

Allows to import NG commands in the selected page 

Offset correction will be available on selected part program. 

Follow the instructions given in the GAUGE “Design” tab to 
configure the command. 
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Viewer settings (“Controls” tab) 

Icon  ID 

Control / 

Command 

Name 

Button Description 

 

 Text  

Allows to add labels inside the page. 

Follow the procedure listed in “Label adding” section to 
configure the label. 

 

 Panel  

Allows to add Panels inside the page. 

Follow the procedure listed in “Panel adding” section to 
configure the label. 

 

 Command  

Allows to add buttons inside the page for the following 
functions:  

- Home: switch-off viewer page 

- Next: switch to next page (according with defined ID) 

- Previous: switch to previous page (according with 
defined ID) 

- Screenshot: allows to save a picture of the page 
(“.bmp”) 

Follow the procedure listed in “Button adding” section to 
configure the label. 
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In the “Design” tab, it is possible to: 
 

 Perform the association between controls and function cards (and section) 
 Perform the association between commands and controls 
 Customize controls view 
 Customize the label 
 Customize the panel 
 Customize the button (home, next, previous, screenshot) 

 
According to the selection (page, control, command, label, panel or button), window like follow can appear: 
 

 
 
Follow the steps indicated in the next sections to correctly perform the associations and customize the pages.  

 

Viewer settings (“Design” tab) - PAGE 

Icon  ID Setting Name Button Description 

  Title  
It defines page title wich can be displayed or not according 
with “Show page title” checkbox. 

  
Show page 
hotkey 

 It allows to define current page hotkey. 

 

 
Background 
color 

 
Allows to define page background color. It is available only 
if “Transparent background” checkbox is not checked 

 

 
Background 
image 

 
Allows to import page background image (“.bpm” “.png” 
“.tiff” “.jpg”). It is available only if “Transparent background” 
checkbox is not checked 

Transparent 

background 

 

 
Transparent 
background 

 
[check box]. When enabled, page background becomes 
transparent. Background color and image are not available 
anymore 

Show page 

title 

 

 Show page title  
[check box]. When enabled, page title will be shown. 
Available if transparent background checkbox is not 
enabled 

  
Background 
layout 

 
It allows to define the layout of the image imported with 
“Background image” button. 

 

 Undo  Undo last modification (Ctrl + Z) 

 

 Redo  Redo last modification (Ctrl + R) 

 

 Delete  It deletes selected object (Canc) 

 

 Copy  
It copies selected object on the same or on another page 
(Ctrl + C) 

 

 Cut  
It cuts selected object on the same or on another page  

(Ctrl + X) 

 
 
 



Release: 220128 
  9UMENX519-1200 

  VMX5 HMI – INSTALLER 
 

 
 

3-55 

Viewer settings (“Design” tab) - PAGE 

Icon  ID Setting Name Button Description 

 

 Paste  
It pastes copied or cutted object on the same or on another 
page (Ctrl + V) 

 

 
Size and 
position 

 
Allows to define height, width and position of selected 
object (control, command, label or panel). Size and position 
modification it is also possible using the mouse. 

 

 Bring to front  
Bring to front selected object (control, command, label or 
panel) 

 

 Send to back  
Send to back selected object (control, command, label or 
panel) 

 

 

 

Unlock position 

 

Lock position 

 
Unlock / Lock the position of the selected object on the 
screen 
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According to selected control, different customizations are available: 
 

Viewer settings (“Design” tab) - BALANCER 

Icon  ID Setting Name Button Description 

RPM 

diagram 

 

 RPM diagram  

Enables \ Disables RPM diagram view: 

 

RPM info 

 
 RPM info  

Enables \ Disables RPM info view: 

 

RPM value 

 
 RPM value  

Enables \ Disables RPM value view: 

  

Balancing 

head 

 

 Balancing head  

Enables \ Disables motors status view: 

 

Value 

 
 

Unbalance 
magnitude 

 

Enables \ Disables unbalance magnitude value view: 

 

Phase 

 
 

Unbalance 
Phase 

 
Enables \ Disables unbalance phase value view: 

 

% width  Diagram width  

Defines polar diagram dimension related to the entire 
control page. 

 

Drop-down 

menu 
   

Full: all the views are enabled (RPM, unbalance, diagram, 
motors). 

Graph: polar diagram and unbalance info are enabled only. 

Debug: 

RPM: RPM info are enabled only. 

Motors: motors status are enabled only. 

Custom_1: polar diaram, unbalance info and RPM value 
are enabled 

Custom_2: polar diaram, unbalance info, RPM value and 
motors status are enabled 

Drop-down 

menu 
   

Base: tollerances on polar diagram are indicated as a 
colored circumferences 

Advanced: tollerances on polar diagram are indicated as a 
colored area 

Header 

 
 Header  [check box]. When enabled, control caption will be shown.  
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Viewer settings (“Design” tab) - BALANCER 

Icon  ID Setting Name Button Description 

Color 

options 
   

It is possible to customize the page choosing favourite color 
for the following objects: 

 Background  Grid 

 Axis  Fore (variables) 

 Trace  Axis label 

 Min tolerance  Max tolerance 

 Max vibration  Header color 
 

 

 

 

Viewer settings (“Design” tab) – TOUCH DETECTOR 

Icon  ID Setting Name Button Description 

Variables 

 
 Variables  Enables \ Disables variables value view. 

Vx 

 
 Vx  Enables \ Disables Vx (V1, V2, V3, V4) value view. 

Vx Peak 

 
 Vx Peak  

Enables \ Disables Vx Peak (V1, V2, V3, V4) value view. 

Peak value is indicated in square brackets []. 

Header 

 
 Header  

[check box]. When enabled, control or command caption 
will be shown.  

Color 

options 
   

It is possible to customize the page choosing favourite color 
for the following objects: 

 Background  Grid 

 Axis  Fore (variables) 

 Trace  Axis label 

 Header color  
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Viewer settings (“Design” tab) – AG GAUGE 

Icon  ID Setting Name Button Description 

Zoom on 

 
 Zoom on  

Enables \ Disables zoom on time graph. Enabling zoom on 
option, gauge and offset values will disappear. 

RPM 

 
 RPM  

Enables \ Disables RPM value view. 

 

Offset  

 
 Offset  

Enables \ Disables offset value view. 

 

Drop-down 

menu 
   

Choose the option according with related part-program: 

In process, roundness, post process, post 
processRoundess: 

Header 

 
 Header  

[check box]. When enabled, control or command caption 
will be shown.  

Color 

options 
   

It is possible to customize the page choosing favourite color 
for the following objects: 

 Background  Grid 

 Axis  Fore (variables) 

 Trace  Axis label 

 Header color  
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Viewer settings (“Design” tab) – NG GAUGE 

Icon  ID Setting Name Button Description 

Zoom on 

 
 Zoom on  

Enables \ Disables zoom on time graph. Enabling zoom on 
option, gauge and offset values will disappear. 

RPM 

 
 RPM  

Enables \ Disables RPM value view. 

 

Offset  

 
 Offset  

Enables \ Disables offset value view. 

 

Drop-down 

menu 
   

Choose the option according with related part-program: 

In process, roundness, post process, post 
processRoundess. 

ShowGraph 

 
 ShowLinearEnc   Enables \ Disables gauge graph view. 

ShowDebug 

 
 ShowDebug  Enables \ Disables debug variables view. 

ShowStatus 

 
 ShowStatus  Enables \ Disables status icons view. 

ShowBarGraph 

 
 ShowBarGraph  Enables \ Disables gauge bar graph view. 

ShowHeadBar 

 
 ShowHeadBar  Enables \ Disables gauge heads bar graphs view. 

ShowQuote 

 
 ShowQuote  Enables \ Disables gauge and offset values view. 

ShowManData 

 
 ShowManData  

Enables \ Disables the view of following values: 

 G2, G3, G4  

  

  
 

Header 

 
 Header  

[check box]. When enabled, control or command caption 
will be shown.  

Color options    

It is possible to customize the page choosing favourite color 
for the following objects: 

 Background  Grid 

 Axis  Fore (variables) 

 Trace  Axis label 

 Header color  
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3.2.2.1.1 Custom page generation procedure 

 In the HMI layout tab, check  “View Designer” checkbox and click on button. 

 Click on page list button  in “Home” tab.  
 

 
 Choose the page to configure with mouse double-click (i.e.: <Page_1>).  

A window like the following will appear. 
 

 
 Select  “Design” tab in order to configure page properties and layout: 

 

 
 

In “Design” tab is possible to configure: 

- Title of the page. It will be displayed instead of <Page_1>. 

- Page hotkey (i.e.: Ctrl + F1). To recall the page. 

- Background color  or Background image . These features are available if 
“Transparent background” checkbox is not checked only. 

- Page size and position with  button. Alternatively it is possible to resize and 
move the page using the mouse. 

- Define page layer with  and buttons. 

 Once page properties and layout has been defined, page position locking  is suggested. 

 Save the current work with button in “Home” tab. 
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Once page properties and layout has been defined, it is possible to add following objects inside the page: 
 

 Function cards controls (Balancer, Touch detector, AG, NG) 
 Commands (association with related control is required) 
 Label 
 Panel 
 Button 

3.2.2.1.1.1 Adding of function cards controls 

 Select  “Controls” tab in order to define the control to import inside the page: 

 
 

 Select desired control clicking with the mouse (i.e.: TD full). 
 Using the mouse, draw inside the page the portion intended for selected control. 

 

 
 Click on drawn control inside the page and then select  “Design” tab in order to configure control 

properties and layout. 
 

 
 

In “Design” tab is necessary to perform the association between drawn control and related function 
card (and plane or section accordingly with proper function card); i.e.: TD# 1 and Section# A. 
 
In “Design” tab is also possible to configure: 

- Caption of the control. It will be displayed instead of function card name. 

- Control size and position with  button. Alternatively it is possible to resize and 
move the control using the mouse. 

- Define control layer with  and buttons. 

 Once control properties and layout has been defined, control position locking  is suggested. 

 Save the current work with button in “Home” tab. 
 
Note: Drawn control will display all the limits or tollerances or variables defined with selected part-program. 
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3.2.2.1.1.2 Adding of function cards commands 

 Select  “Controls” tab in order to define the command to import inside the page. Available commands 
are: 

- TD card limits adjustment 

- AG and NG offset adjustment 
 

 
 

 Select desired command clicking with the mouse (i.e.: TD command). 
 Using the mouse, draw inside the page the portion intended for selected command. 

 

 
 

 Click on drawn command inside the page and then select  “Design” tab in order to configure 
command properties and layout. 

 

 
 

In “Design” tab is necessary to perform the association between drawn command and drawn control: 

- click on “Control” button. Viewer setting page will ask to click on the associated drawn 
control. 
 

 
 

- Click on the drawn control inside the page. Then a message of occurred coupling will 
appear. 
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In “Design” tab is also possible to configure: 

- Command caption (Header checkbox needs to be checked). 

- command size and position with  button. Alternatively it is possible to resize 
and move the command using the mouse. 

- Define command layer with  and buttons. 

- Caption script color (Header checkbox needs to be checked). 

- Caption background color (Header checkbox needs to be checked). 

 Once control properties and layout has been defined, control position locking  is suggested. 

 Save the current work with button in “Home” tab. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Release: 220128 
  9UMENX519-1200 

  VMX5 HMI – INSTALLER 
 

 
 

3-64 

3.2.2.1.1.3 Label adding 

 Select  “Controls” tab in order to select label object   to import inside the page.  
 

 
 Using the mouse, draw inside the page the portion intended for selected label. 

 

 
 Click on drawn label inside the page and then select  “Design” tab in order to configure label 

properties and layout. 

 
In “Design” menu is possible to configure: 

- Label ID. 

- Label caption . 

- Label size and position with  button. Alternatively it is possible to resize and 
move the label using the mouse. 

- Define label layer with  and buttons. 

- Define label background color, font, script color and script formatting. 

 Once label properties and layout has been defined, control position locking  is suggested. 

 Save the current work with button in “Home” tab. 
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3.2.2.1.1.4 Panel adding 

 Select  “Controls” tab in order to select panel object    to import inside the page.  
 

 
 Using the mouse, draw inside the page the portion intended for selected panel 

 
 Click on drawn panel inside the page and then select  “Design” tab in order to configure panel 

properties and layout 

 
In “Design” menu is possible to configure: 

- Panel ID. 

- Panel caption . 

- Panel size and position with  button. Alternatively it is possible to resize and 
move the panel using the mouse. 

- Define panel layer with  and buttons. 

- Define panel background color or background image,  image location inside the 
panel. 

 Once label properties and layout has been defined, control position locking  is suggested. 

 Save the current work with button in “Home” tab. 
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3.2.2.1.1.5 Button adding 

 Select  “Controls” tab in order to select Cmd object    to import inside the page.  
 

 
 

 Using the mouse, draw inside the page the portion intended for selected button 
 

 
 Click on drawn button inside the page and then select  “Design” tab in order to configure button 

properties and layout 
  

 
 
In “Design” menu is possible to configure: 

- Button label. It will be displayed clicking on “Control list” button  

- Button size and position with . Alternatively it is possible to resize and move the 
button using the mouse. 

- Define button layer with  and . 

- Define button background color. 

- Define the function of the button: 

 Home: switch-off viewer page  

 Next: switch to next page (according with defined ID)  

 Previous: switch to previous page (according with defined ID)  

 Screenshot: allows to save a picture of the page (“.bmp”)  
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 Once button properties and layout has been defined, control position locking  is suggested. 

 Save the current work with button in “Home” tab. 
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3.2.2.1.1.6 Page export and import 

Once custom page has been completed, it is possible to export the page in order to import it on another 
machine or PC.  

 Click on page list button  in “Home” drop-down menu.  
 

 
 Choose the page to export with mouse one-click (i.e.: <Page_1>).  

 Click on export page button in order to choose the name of “.bpg” file and folder destination. 
 

In order to import the page, click on import page button  and choose the “.bpg” file to import. 
 
 
Custom page example in the picture below :  
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3.2.3. Data recording   

 
From the individual device screens it is possible to record a set of system status and variable values with a 
given timing on a file for analysis and documentation purposes. 

To access the data recording option setting, use the Parameters   [Shift+F7] commend on the 
System page. 
 

 Select the Data recording tab 
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Parameter Description 

Command enable 

 
(check box). Enables the Record command  
[Shift+F4] that allows the process data of the function 
cards to be recorded on the file 

Sampling rate [s] 

[0.1 s] 

Indicates the time elapsing between the recorded 
samples 

Max file size [kbyte] 

[500 kb] 
When the maximum size is reached, the file is closed 
and a new file is opened. 

Max folder size [Mbyte] 

[10 Mb] 

Maximum size of the archive folder of the recordings. 
When the maximum size is reached, the operator is 
notified and he has to remove the files. 

Data folder 

<Drive>:\BalanceSystems\VMx\DataRec 

Definition of the destination folder where the data files 
will be stored. 

Storage file mangement 

[ Automatic ] 

Automatic: when DataRac folder is full the system will 
apply FIFO management: older files will be deleted. 
Manual: when DataRac folder is full the system will 
display a message box. The operator should remove 
manually the older files. 

 
 
The files are archived in ASCII format in the default folder (see parameters table) with the following name: 

 

BSREC_YYMMDD_hhmmss.txt 
 
where: 

YY year 
MM month 
DD day 
hh hour 
mm minute 
ss second 

 
The following table summarizes the format of the recorded data for each device. All information in the text file is 
headed in English. 
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Device 
Device ID 

Date - Time Data 

Balancer FFT 1..4 
yy/mm/dd 

hh:mm:ss 

“Step”  component number 

“RPM”  rotation speed 

“Frequency” frequency equivalent to rotation speed 

“Magnitude” magnitude of the vibration component 

Balancer 1..4 
yy/mm/dd 

hh:mm:ss 

“Status flag” status in progress 

“RPM”  rotation speed 

“PA: Unb Qty”  unbalance quantity on plane A 

“PA: Unb Pos” unbalance position on plane A 

“PB: Unb Qty”  unbalance quantity on plane B 

“PB: Unb Pos” unbalance position on plane B 

Touch Detector 1..4 
yy/mm/dd 

hh:mm:ss 

“Vx: Am”     average value 

“Vx: Ip”     max value 

“Vx: Im”     min value 

“L1”         Limit 1 output status 

“L2”         Limit 2 output status 

“L3”         Limit 3 output status 

“L4”         Limit 4 output status 

Gauge 1..4 
yy/mm/dd 

hh:mm:ss 

“RPM”  Rotation speed 

“Dimension” Dimension of the part 

“LE”  Linear encoder position 

“Fn”   Fine dimension 

“G2”  Value of the G2 transducer  

“G3”  Value of the G3 transducer  

“G4”  Value of the G4 transducer  

“G5”  Value of the G5 transducer  

Gauge Roundness 1..4 
yy/mm/dd 

hh:mm:ss 
 

 
 
 

IMPORTANT: The system will record the data of the current device displayed. Other variables are recorded 
for diagnostic purposes. 
 
 
The following example shows the format of the text file content generated for the Touch Detector card. The 
REC file contents is strictly related with the part-program in use. 
 
Example “BSREC_161118_135239.txt” contains data recorded on 18 November 2016 starting at 13:52:39. 
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System commands 

Icon  ID 
Command 

Name 
Button Description 

 
0011 Print Shift+F4 Print the displayed screen 

 

0017 Exit Shift+F8 Exit & save the configuration 

 
0020 Folder View F5 Allow the archiving folder of the REC files to be selected 

 
 

3.2.3.1. Recording commands 

 
There are 4 mode to START / STOP data recording. 
 
 

Mode Action Description 

Manual 
 

Start / Stop by user. See paragraph 2.1 

Auto - 1 Digital I/O 
Start / Stop by digital I/O interface. See document presente 
at the link Components 

Auto - 2 Profibus / Profinet 
Start / Stop by Profibus or Profinet interface. See document 
present at the link Multinet 

Auto - 3 Call in VMx5-HMI controls Start / Stop by properties in HMI graphic controls. 

 
 
NOTE: 
 
The command START REC opens a new data file and store the data. 
The command STOP REC closes the data file. 
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3.2.4. Print  

 
This allows printing of the current displayed screen on the default printer device. 
 

Select the Parameters command  [Shift+F7] on the system page.  
 

 Select the Print tab 
 
 

 
 
It is possible to set a print report header containing the following information: 
 
 
 

Parameter Description 

Manufacturer Company name of the machine manufacturer (OEM) 

Machine Machine model 

Number Serial number of the machine 

User Company name of the machine user 

Print margins Definition of the printer margin areas 
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System commands 

Icon  ID 
Command 

Name 
Button Description 

 
0011 Print Shift+F4 Print the displayed screen 

 

0017 Exit Shift+F8 Exit & save the configuration 
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3.2.5. Summary of the HMI parameters 

 

 
 SETUP     

 

 HMI 

 LANGUAGES 

Remote change language 

Italian 

English UK 

English US 

German 

Spanish 

French 

Russian 

Traditional Chinese 

….. 

 

 CONNECTION 

 TCP/IP CONFIGURATION 

Host address 

Host port 

Manual management of the communication layer 

HMI Id 

HMI demo mode 

 SERIAL PORT CONFIGURATION 

COM port 

Baud rate [bps] 

 CPU PREFERENCES 

Priority 

Affinity 

CPU 0,1,2,… 

Graphic control sampling 

 

 

  DEVICES 

 Balancer 

Device 1 

 Touch Detector 

Device 1 

 Gauge 

Device 1 

 Multinet 

Device 1 

 

 

 DATA RECORDING 

Command enable 

Sampling rate 

Max file size 

Max folder size 

Storage files management 

Data folder 

 

 PRINT 

OEM 
Machine 
Machine Number 
End user 
Printer margins 

 

 VM Link 

Search VM Link 
Stop search VM Link 

 

 

 

  

  
 

 

 LAYOUT 

SETTING 

Layout  

Color palette 

Header height 
Width (for custom layout only) 

Height (for custom layout only) 

X position (for custom layout only) 

Y position (for custom layout only) 

Fix size (for custom layout only) 

Fix location(for custom layout only) 

Full Screen 

Window Border 

Tooltips 

Smart change page 

Quick shortcut 

Start HMI page 

Start VIEWER page 

Viewer Designer 

 

 KEYBOARD 

BOTTOM / SIDE BAR 

Button height / width 

Left / Top margin 

Vertical / Horizontal spacing 

Number of buttons 

Corners 

 

 ICONS 

Command icons (size) 

State icon (size) 

Active command icons color  

Inactive command icon color 

State icon color 

Quality 

 

 COLOR 

Info panel background 
Info panel text 
Panel background 
Buttons: background 
Buttons: text 
Buttons: border 
Buttons: selected 
Buttons: selected 2 
Parameters: background 
Parameters: text 
Parameters: selected background 
Parameters: selected text 
Device header: background 
Device header: text 
Device: text color 2 
Device: text  
Device: background 
Diagram: background 
Diagram: axis 
Diagram: cursor 
Diagram: grid 

Diagram: trace 
Diagram header: text (active) 
Diagram header: background (active) 
Diagram header: text 
Diagram header: background 
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3.3. Devices software setup 

 
The correct use of the devices 
 

 Balancer 
 Touch detector 
 Gauge 
 Multinet 

 
needs to define a sets of parameters. Devices parameters are divided in three groups: 
 
two are defined by system’s installer 
 

 Options   Enabling hardware and software functions 

 Setup     Adjusting hardware devices and sensors / actuators 
 
one is defined by system’s programmer / installer 
 

 Work or Part-Program  Parameters of the process under control 
 
 
NOTE 
To access the parameters, each device should be switched in manual mode.  
 
 
The contents of this chapter should be integrated reading the documentspresent at the link  
 
User Manual 
 
Parameter setup 
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3.3.1. Parameter modification   

 
STARTING FROM THE DEVICE STATUS SCREEN IN MANUAL MODE 
 

- Use the command Change page  [Shift+F2], to reach the desired device (i.e. “Balancer 1”) 
 

- Switch in MANUAL MODE: command Automatic / Manual  [Shift+F6] 
 

- Press Parameters  [Shift+F7] 
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As alternative, starting from the device status screen in manual mode, if “Smart change page” checkbox has 
been flagged in the HMI layout setup: 

 

- Use the command Change page  [Shift+F2], to open “Smart change page” view, then select 
desired page. 
Recent / favorites menu is also available. 
Left-click on desired page, allows to open the page.  
Right-click on desired page allows to customize the name of the page. 
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- Switch in MANUAL MODE: command Automatic / Manual  [Shift+F6] 
 

- Press Parameters  [Shift+F7]  
 
 

System commands 

Icon  ID 
Command 

Name 
Button Description 

 

0011 Print Shift+F4 Print the current parameter page 

 

0019 Factory preset F1 Load the default value (factory preset) 

 

0008 Info Shift+F3 
Additional information about the parameters, for diagnostic 
purposes. Helpful in case of guided procedure by Balance 
Systems’s service personnel. 

 

0036 I/O Test F2 
Access to the I/O Test function to check the device digital 
interface wiring. 

 

0021 
Parameter list 
display 

F7 Explore the parameters tree 

 

0033 Previous menu F8 One level back in the parameters tree 

 

0017 Exit Shift+F8 Exit & save the configuration 
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In the parameter modification page are present the following areas:      
 

A. Actual parameter page and position in the device parameter tree 
B. For each parameter are indicated: 

 
 Description (parameter’s name) 
 Actual value 
 Measuring unit 

In case of extended information through the command Info  [Shift+F3] 
 

 ID, Id number of the parameter 
 AL, access level required to modify the value 

 
 

 
 
 

A 

B 

C 
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C. For each parameter with numerical format, are indicated: 
 

 Min value 
 Max value 
 Defualt value (factory preset) 
 Actual value 

 

For each parameter with list format, are indicated: 
 

 Defualt value (factory preset) 
 Actual value 
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3.3.2. Digital I/O Test  

 
To make installation easier during cabling and connection of the system to the machine’s CNC, a special 
function of digital I/O test has been implemented which can be accessed from the setup stage of each of the 
following function cards: 
 

 BALANCER 
 TOUCH DETECTOR 
 GAUGE 
 MULTINET 

 
 

 
 

 Press the command I/O Test  [F2] 
 

The test function displays the status of input signals to the function card and enables forcing the 
status of each output. In this way it is extremely easy to carry out a full test of the connections made. 
The figure below gives an idea of a typical screen page of the I/O test function. 
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System commands 

Icon  ID 
Command 

Name 
Button Description 

 
0011 Print Shift+F4 Print the current parameter page 

 
0040 

Digital output 
enable 

F1 Set the actual pin at high level 

 
0039 

Digital output 
disable 

F2 Set the actual pin at low level 

 
0029 Left F3 Select the previous pin 

 
0030 Right F4 Select the next pin 

 
0027 Up F5  

 
0028 Down F6  

 
0017 Exit Shift+F8 Exit 
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3.4. Touch detector [type TD] 

 

3.4.1. Acoustic Emission Variables setup 

 

3.4.1.1. Introduction 

 
The best performances of the AE sensors require the setup of some parameters by the system installer.  
 
The concept of the signal processing is shown in the picture below. 
 
 
 

 
 
Starting from the AEx sensors connected to the inputs of the card (connectors D8, D5) it is necessary to 
define the Vx variables to perform the process control. 
 
A Vx variable is the result of the processing performed on the analog and digital signal generated by an AEx 
sensor. 
 
The default setting of the system requires that there is a direct correspondence between the sensors 
connected to the inputs and the variables, therefore: 
 
AE1 sensor  connected to input connector D8  > Variable V1 
AE4 sensor (AUX) connected to input connector D5  > Variable V4 
 
Depending on the characteristics of the process to be controlled and the type of sensors which equip the 
machine, it is possible to change the association. So, the same sensor (that means the same source signal) 
can be treated by different filtering to generate different variables, such as : 
 
AE1 sensor  connected to input connector D8  > Variable V1 
         > Variable V2 
         > Variable V3 
 
The Vx variables created, are used within the formulas of the part program to define the outputs L1, L2, L3, 
L4. 
 
 
 
 

 
FILTERS 

SECTION A 

P-P 1 

P-P 2 

P-P n 

... 

L1 = N aV1 > 10.0 + ...  
L2 = ... + ... + ... + ...  
L3 = ... + ...  
L4 = ... + ...  

P-P 1 

V1 
AE1 

FILTERS 
V2 

 

FILTERS 
V3 

 

 
FILTERS 

V4 
AE4 
aux 

 
 
 
 
 
 

MIXER 

Vx VARIABLES AEx INPUTS  

PART-PROGRAMS 

LIMITS 
(OUTPUT DEFINITIONS) 
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3.4.1.2. Configuration mode, Variable setup, Sections and Part-Program 

 
Depending on the processes that have to be controlled, the system installer may want to enable, via the 
options menu, the following features: 
 

a) Mode of operation of the frequency analysis 
b) 4 setup of Vx VARIABLES: S1, S2, S3 e S4 
c) Up to 4 sections, that means up to 4 processes simultaneously controlled: Section A, Section B, 

Section C and Section D 
d) The use of the part-program, in a number depending on the number of sections enabled: 

 
1 section:  Section A     > max 16 part-program 
2 sections:  Section A and Section B     > max 8 part-program (per section) 
4 sections:  Section A, Section B, Section C and Section D  > max 4 part-program (per section) 
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ID Parameter Description 

 
Configuration mode 

[BASE] 

Depending on the hardware with which the card is configured 
and the type of sensor used, the acquisition system can work 
in 3 different ways with increasing complexity of programming. 
 

BASE mode 

MULTIBAND mode 
 

See the table below and next paragraphs for a complete 
description 

 
Vx Setup 

[OFF] 

Enabling of multi setup variables 

OFF:  Each Vx variable has one setup only 

ON:  It is possible to define up to 4 different setup for the 
same Vx variable 

 
Part Program 

[OFF] 

Enabling of Part-Program use 

OFF:  Disabled. Part-Program No.1 is the only available. 

ON:  Depending on the No. of sections enabled, a number 
of part-program are available: 

 

Section A      > 16 Part-Program 
Sections A+B      > 8 Part-Program per section 
Sections A+B+C+D > 4 Part-Program per section 

 
Sections 

[A] 

Enabling of No. of Sections, means No. of simultaneous 
processes, to be controlled. 

A:   1 process 

A+B:   2 processes 

A+B+C+D:  4 processes 

 

No. Sensor Mounting 

Typical Setup 

Configuration 

Mode 

Frequency 

Window 

1 
 

Static mounting (machine table, work 
head body, tail stock body, blade 
dresser body, spindle housing, etc.) 

BASE-BAND n.a. 

2 
 

Static mounting (machine table, work 
head body, tail stock body, blade 
dresser body, spindle housing, etc.) 

BASE-BAND 
MULTI- BAND 

0 .. 4 

3 
 

Nose spindle mounting (grinding 
spindle OD - ID, dressing spindle, 
etc.) 

MULTI-BAND 1..4 

4 
 

Built-in spindle mounting (grinding 
spindle OD - ID, dressing spindle, 
etc.)  

MULTI-BAND 1..4 

5 
 

Built-in spindle mounting (grinding 
spindle OD - ID, dressing spindle, 
etc.) 

MULTI-BAND 1..4 

6 

 

Rotating ring (grinding spindle, work-
head, etc.)  

MULTI-BAND 1..4 

7 
 

Hydrophone static mounting (working 
coolant through) (grinding area, 
dressing area, etc.) 

BASE-BAND n.a. 
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3.4.1.3. Preliminary operation for the system optimization 

 
The following operations are common to all three configuration modes (basic, multi-band, enhanched) of the 
system. 
 
Here are the commands available to access the setup. 
 

 
 
 
 
 
 
 
 
 
 
 
 

1A = Device No.1, Section A 
1  = Part-Program No.1 active 
S1 = Setup No.1 active 
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Commands 

Icon  ID 
Command 

Name 
Button Description 

 

0042 Reset F1 Status and Output signaling reset 

 

4006 Formula setup F2 Access to formula editing 

 

4005 
Quick Limits 1, 
2, 3 & 4 
correction 

F3 
Quick access to fine adjustment of the thresholds related to 
limits in the formula 

 

0041 
Part program 
seect 

F4 

Part-Program selection for manual mode operations. 
With this parameter one imposes one of the available 
programs for the selection of the gap eliminator. The 
programs are numbered from 1 to n. 
By imposing 0, the program selected by the CNC of the 
machine will be activated. When selecting a number from 1 
to n, a specific program will be imposed, which does not 
give the possibility to the CNC, to use a different program 
 
NOTE: Operating in automatic mode the selection made by 
PLC/NCU has the priority. 

 

0034 
Next commands 
line 

F8 Access to next commands line 

 

4061 
Variable V1 
setup 

F2 
Access to frequency analysis function to setup the V1 
variable 

 

4064 
Variable V2 
setup 

F3 
Access to frequency analysis function to setup the V2 
variable 

 

4067 
Variable V3 
setup 

F4 
Access to frequency analysis function to setup the V3 
variable 

 

4070 
Variable V4 
setup 

F5 
Access to frequency analysis function to setup the V4 
variable 

 

4079 
Power sensor 
setup 

F6 
Direct access to setup parameter page of the POWER 
channel [Connector D4] 

 

4007 
Change Vx 
Setup 

F7 

Vx Setup selection for manual mode operations. 
With this parameter one imposes one of the four available 
Vx Variables Setup. The setup are numbered from 1 to 4. 
By imposing 0, the setup selected by the CNC of the 
machine will be activated. When selecting a number from 1 
to 4, a specific setup will be imposed, which does not give 
the possibility to the CNC, to use a different setup. 
 
NOTE: Operating in automatic mode the selection made by 
PLC/NCU has the priority. 
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1. If enabled the management, select the setup of the variables among the 4 available (S1, S2, S3 or 
S4) 
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2. If enabled management, select the working section between the 4 available (A, B, C, or D) 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1A = Device No.1, Section A 
1  = Part-Program No.1 active 
S1 = Setup No.1 active 

Push the button 
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3. If enabled the management, select the part program among those available based on the number of 

working sections defined (PP1, ..., PPn) 
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4. Fill the part program by introducing the desired variables, such as: 
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3.4.1.4. BASE mode optimization 

 
The system displays the entire available frequency band. 
 
 
It is possible to progam: 
 

Parameters 

Icon  ID 
Parameter 

name 
Button Description 

 
4071 Source F3 

Choice of the AE sensor channel which generates the input 
signal 

 
4056 Gain B F4 Amplification of the input signal. 

 
4030 

Band Pass 
Filter 

F5 
Up to 2 Band Pass filters inside the selected window. The 
filters can be switched on/off and placed independently 
inside the selected window. 

 
4073 RMS Filter F4 

Low pass filter value which gives a reduction of 
disturbance, eliminating the high frequency components. 
The higher the value entered, the greater the attenuating 
effect of the high frequency which is achieved. 

 
4072 Fullscale F5 

Value of the signal associated to 100%. The fullscale can 
be used to normalize the input signals. 

 
 
The setup page, based on frequency analysis, is designed to reach the best behaviour during the 
optimization task. 
With few operations, it is possible to setup both the sensibility and the frequency range where the AE signals 
should be observed to avoid that background and environment noise generate false signalling. 
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1. Access to the setup of the variables used in the part program written above: 

 
 

On screen are identified the following areas: 

A. Selected channel 

C. Diagrams area  

- Vx vs frequency diagram (spectrum) 

- Vx vs time diagram 

- Input  signal level on A/D converter input [%] 

- Vabs istantanous value of the Vx variable 

- Vpeak Vx peak value (zeroed by reset) 

- Gain B value of the input signal amplification 

- RMS value of the RMS filter 

- Fullscale  value of fullscale 

 

D. Command buttons [Fx]  

S1 = SETUP No.1 selected 
Variable V1 generated by 
AE1 sensor (connector D8) 

A 

C 

D 
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The available commands are described in the table below. 
 

Parameters 

Icon  ID 
Parameter 

name 
Button Description 

 

4046 FFT Reset F1 Status reset 

 

4047 
FFT  

run-time 
F2 FFT in run-time mode 

 

4045 
FFT peak 
detector 

F2 FFT in peak detector mode (default) 

 

4050 Zero FFT F3 Background noise spectrum acquisition 

 

4049 
Reset  

Zero FFT 
F3 Background noise spectrum reset 

 

4056 Gain B F4 Gain B setup. Gain of the input signal 

 

4030 Filters F5 Digital filters setup 

 

4048 FFT Setup F2 Other parameter setup 

 

4071 Link to source F3 
Choice of the AE sensor channel which generates the input 
signal 

 

4073 RMS Filter F4 RMS FIlter 

 

4072 Fullscale F5 Variable fullscale 

  

 

4076 

 

4075 

Sensor ready F6 Sensor ready check enable / disable 

 
4074 

Downsample 
filter  

F7 Accesses the downsample filter setup 

 
0017 Exit Shift+F8 Exit 
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2. Bind the Vx variable to the signal source (AEx sensor), example: V1 <=> AE1 
 
 

 

 Set the value then press  [Shift+F8] to save it 
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3. Execute the optimization starting from the parameter suggested in the following table 
 
 

No. Sensor 

Typical Setup 

Gain B 
Digital 

Filters 

RMS 

Filter 
Full scale FFT mode 

1 
 

4 OFF 100 100 

 

2 
 

4 OFF 100 100 

 

7 
 

4 OFF 50 100 

 

 
 

and operating as follow: 
 
a. Run-up the spindle up to nominal speed and position the axis close to touch conditions (wheel-

part or wheel-dresser) 

b. Press one or more the button  [F1]  

c. Verify that in such condition the background noise detected is: 

 

Input < 50 % 

Vabs < 30.0 
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d. Eventually, change the “Gain B” (see the next point “i” to know how to do it) to be as close as 

possible to the indicated conditions. 

e. Press the button  [F1]  

 
f. Execute a touch grinding 

 

 

g. Watch on the frequency diagram where are the signals generated by the contact. At this purpose 

can be useful to execute a Zero FFT  [F3] command. In this way, only the differences 

between the signal and the background noise will be displayed. 

h. Repeat the touch grinding and press the button  [F1] each time.  

 

i. If necessary, to obtain the optimization it is possible to modify: 
 

GAIN B 

 Increase or decrease the Gain B  [F4] to obtain a signal to noise ratio 2:1 at least. 
 

Touch signal 
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Selected 
Gain B 

Decrease / Increase 
Gain B 

Touch signal 

Touch signal 

Exit & save the new Gain B 
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DIGITAL FILTERS 

 Add or modify the position of the Digital Filters  [F5] to center the fequency 

range around the right signal. It is suggested to keep the range as wide as possible in 

comparision with the background noise. 

There are up to 2 programmable band-pass digital filters. Each band pass filter is 
composed of: 

 
 1 Low Pass filter (LP) 
 1 High Pass filter (HP) 

 
The filters can be switched on / off and placed over the entire available bandwidth. 
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Move Left / Right 
High Pass filter 

Move Left / Right 
Low Pass filter 

Filter 
OFF 

Switch on and setup the Pass 
Band Filter No.1 

NOTE: The icons replay the 
index of each filter  

High Pass filter No. 1 
Index position 

Selected 
Frequency band 

Low Pass filter No.1 
Index position 
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Use of 2 Band-Pass filters: 
 

 
 

Move Left / 
Right 

High Pass filter 

Move Left / 
Right 

Low Pass filter 

Filter 
OFF 

Toggle the two buttons to switch on and 
setup the Pass Band Filters No.1 & No.2 

NOTE: The icons replay the 
index of each filter  

Low Pass filter No. 1 
Index position 

High Pass filter No.1 
Index position 

Selected 
Frequency bands 

High Pass filter No.2 
Index position 

Low Pass filter No. 2 
Index position 
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RMS FILTER and FULLSCALE 
 

 Further optimizations can be obtained by changing the value of the RMS Filter. This will 
smooth the high frequency noise components. Be careful not to use too much high value 
for the filter to not affect the response time of the system. 

 
 

ID Parameter Description 

 
RMS filter 

[100] 

Low pass filter value which gives a reduction of disturbance, 
eliminating the high frequency components. The higher the 
value entered, the greater the attenuating effect of the high 
frequency which is achieved. 

 

 
 

 
 
 
 
 
 
 
 
 
 
 

RMS Filter = 100 

RMS Filter = 250 



Release: 220128 
  9UMENX519-1200 

  VMX5 HMI – INSTALLER 
 

 
 

3-104 

 Change the fullscale to vary the normalization of the Vx variable (this is normally not 
necessary). 

 

ID Parameter Description 

 
Full-scale  

[100] 

Value of the signal associated to 100%. The fullscale can be 
used to normalize the input signals. 
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4. Once it is found a satisfactory setup in terms of signal / noise ratio, switch to the normal display mode 
(standard) and perform sufficient testing to verify the stability and repeatability of the calibration 
performed. 
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3.4.1.5. MULTI-BAND mode optimization 

 
The system displays the entire available frequency band divided into 8 windows of observation. The pre-
selected window is zoomed and analyzed in the working area. 
 
It is possible to progam: 
 

Parameters 

Icon  ID 
Parameter 

name 
Button Description 

 
4071 Source F3 

Choice of the AE sensor channel which generates the input 
signal 

 

4051 

 

4052 

Window 

F5 

 

F6 

Window which define the frequency band observed. The 
selected window is then zoomed in the working area. 

 
4053 Gain A F4 Amplification of the signal inside the selected window. 

 
4056 Gain B F4 Amplification of the input signal. 

 

4010 

 

4009 

Filters Enable F2 Filters setup enable / disable 

 
4030 

Band Pass 
Filter 

F5 
Up to 2 Band Pass filters inside the selected window. The 
filters can be switched on/off and placed independently 
inside the selected window. 

 
4073 RMS Filter F4 

Low pass filter value which gives a reduction of 
disturbance, eliminating the high frequency components. 
The higher the value entered, the greater the attenuating 
effect of the high frequency which is achieved. 

 
4072 Fullscale F5 

Value of the signal associated to 100%. The fullscale can 
be used to normalize the input signals. 

 
 
 
 
The setup page, based on frequency analysis, is designed to reach the best behaviour during the 
optimization task. 
With few operations, it is possible to setup both the sensibility and the frequency range where the AE signals 
should be observed to avoid that background and environment noise generate false signalling. 
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1. Access to the setup of the variables used in the part program written above: 

 
On screen are identified the following areas: 

 

A. Selected channel 

B. Full band width and selected window (example: No.2) 

C. Diagrams area  

- Vx vs frequency diagram (spectrum) 

- Vx vs time diagram 

- Input  signal level on A/D converter input [%] 

- Vabs istantanous value of the Vx variable 

- Vpeak Vx peak value (zeroed by reset) 

- Gain A value of the amplification in the selected window 

- Gain B value of the input signal amplification 

- RMS value of the RMS filter 

- Fullscale  value of fullscale 

D. Command buttons [Fx]  

 

S1 = SETUP No.1 
selected 

A 
B 

C 

D 

Variable V1 generated by 
AE1 sensor (connector 
D8) 
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The available commands are described in the table below. 
 

Commands 

Icon  ID 
Command 

name 
Button Description 

 

4046 Reset F1 Status reset 

 

4047 
FFT  

run-time 
F2 FFT in run-time mode 

 

4045 
FFT peak 
detector 

F2 FFT in peak detector mode (default) 

 

4050 Zero FFT F3 Background noise spectrum acquisition 

 

4049 
Reset  

Zero FFT 
F3 Background noise spectrum reset 

 
4048 Parameter F2 Other parameter setup 

 

 

4076 

 

4075 

Sensor ready F6 Sensor ready check enable / disable 

 
4074 

Downsample 
filter 

F7 Accesses the downsample filter setup 

 
4071 Source F3 

Choice of the AE sensor channel which generates the input 
signal 

 

4051 

 

4052 

Window 

F5 

 

F6 

Window which define the frequency band observed. The 
selected window is then zoomed in the working area. 

 
4053 Gain A F4 Amplification of the signal inside the selected window. 

 
4056 Gain B F4 Amplification of the input signal. 

 
4030 

Band Pass 
Filter 

F5 
Up to 2 Band Pass filters inside the selected window. The 
filters can be switched on/off and placed independently 
inside the selected window. 

 
4073 RMS Filter F4 

Low pass filter value which gives a reduction of 
disturbance, eliminating the high frequency components. 
The higher the value entered, the greater the attenuating 
effect of the high frequency which is achieved. 

 
4072 Fullscale F5 

Value of the signal associated to 100%. The fullscale can 
be used to normalize the input signals. 

 
0017 Exit Shift+F8 Exit 
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2. Bind the Vx variable to the signal source (AEx sensor), example: V1 <=> AE1 
 

 

 Set the value then press  [Shift+F8] to save it 
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3. Execute the optimization starting from the parameter suggested in the following table 
 
 

No. Sensor 

Typical Setup 

Window 
Gain 

A 

Gain 

B 

Digital 

Filters 

RMS 

Filter 

Full 

scale 
FFT mode 

2 
 

0 .. 4 100 4 OFF 100 100 

 

3 
 

1..4 100 4 OFF 100 100 

 

4 
 

1..4 100 4 OFF 100 100 

 

5 
 

1..4 100 4 OFF 100 100 

 

6 

 

1..4 100 4 OFF 100 100 
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and operating as follow: 
 
a. Select a suitable working WINDOW and GAIN A following the suggestions in the table above 

 
 

 

 

 

 

 

Decrease / Increase 
Gain A 

Move Left / Right 
Working Window 

Exit & save the new 
Gain A 

Selected 
Gain A 

Selected 
Window 
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b. Run-up the spindle up to nominal speed and position the axis close to touch conditions (wheel-

part or wheel-dresser) 

c. Press one or more the button  [F1]  

 

d. Verify that in such condition the background noise detected is: 

 

 

 

e. Eventually, change the “Gain B” (see the next point “j” to know how to do it) to be as close as 
possible to the indicated conditions. 

f. Press the button  [F1]  
g. Execute a touch grinding  
 

 

Input < 50 % 

Vabs < 30.0 
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h. Watch on the frequency diagram where are the signals generated by the contact. At this purpose 

can be useful to execute a Zero FFT  [F3] command. In this way, only the differences 
between the signal and the background noise will be displayed. 

i. Repeat the touch grinding and press the button  [F1] each time.  
 

 
j. If necessary, to obtain the optimization it is possible to modify: 

 

GAIN A & WORKING WINDOW 
 
Restart with the step (a) 

 

 

GAIN B 

 Increase or decrease the Gain B  [F4] to obtain a signal to noise ratio 2:1 at 
least. 

Touch signal 
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Selected 
Gain B 

Touch signal 

Exit & save the new Gain 
B 

Touch signal 

Decrease / Increase 
Gain B 
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DIGITAL FILTERS 

 Add or modify the position of the Digital Filters  [F5] to center the fequency 

range around the right signal. It is suggested to keep the range as wide as possible in 

comparision with the background noise. 

There are up to 2 programmable band-pass digital filters. Each band pass filter is 
composed of: 

 
 1 Low Pass filter (LP) 
 1 High Pass filter (HP) 

 
The filters can be switched on / off and placed over the entire available bandwidth. 
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Move Left / Right 
High Pass filter 

Move Left / Right 
Low Pass filter 

Filter 
OFF 

Switch on and setup the Pass 
Band Filter No.1 

NOTE: The icons replay the 
index of each filter  

Low Pass filter No.1 
Index position 

Selected 
Frequency band 

High Pass filter No. 1 
Index position 
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Use of 2 Band-Pass filters: 

 
 

 

Move Left / 
Right 

High Pass filter 

Move Left / 
Right 

Low Pass filter 

Filter 
OFF 

Toggle the two buttons to switch on and 
setup the Pass Band Filters No.1 & No.2 

NOTE: The icons replay 
the index of each filter  

Low Pass filter No. 1 
Index position 

High Pass filter No.1 
Index position 

High Pass filter No.2 
Index position 

Low Pass filter No. 2 
Index position 

Selected 
Frequency bands 
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RMS FILTER and FULLSCALE 
 
 

 Further optimizations can be obtained by changing the value of the RMS Filter. This will 
smooth the high frequency noise components. Be careful not to use too much high value 
for the filter to not affect the response time of the system. 

 
 

ID Parameter Description 

 
RMS filter 

[100] 

Low pass filter value which gives a reduction of disturbance, 
eliminating the high frequency components. The higher the 
value entered, the greater the attenuating effect of the high 
frequency which is achieved. 

 
RMS downsample 

[1] 
RMS filter downsample 

 
 

 
 
 
 
 
 
 
 
 

RMS Filter = 250 

RMS Filter = 100 
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 Change the fullscale to vary the normalization of the Vx variable (this is normally not 
necessary). 

 

ID Parameter Description 

 
Full-scale  

[100] 

Value of the signal associated to 100%. The fullscale can be 
used to normalize the input signals. 
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4. Once it is found a satisfactory setup in terms of signal / noise ratio, switch to the normal display mode 
(standard) and perform sufficient testing to verify the stability and repeatability of the calibration 
performed. 
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3.4.2. Power channel setup 

 

To access the Power channel setup press the button   [F6] 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Set the 
Nominal 
Power of 
the motor 

RMS filter 
setup 
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Commands 

Icon  ID 
Command 

name 
Button Description 

 

4073 RMS filter F3 

Low pass filter value which gives a reduction of the noise, 
eliminating the high frequency components. The higher the 
value entered, the greater the attenuating effect of the high 
frequency which is achieved. 

 

4081 Fullscale F4 
Fullscale setup: set the value according to the nominal 
power of the motor [kW] 

 
These two parameters are also accessible by the parameter setup page 

 
 

 
 
 
 

 
 
 
 
NOTE  
In case of power sensor not ready (faulty or not connected to the system), an on screen message will appear. 
The message will disppear as soon as the power sensor will be ready to work properly. 
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4. Appendix 
 

 
 

Documents referred to in the text 

Name 

document 
Paragraphs Link 

Parameter 
setup 

3.1, 3.3 9UMEN2505-1200 Parameter Setup.pdf 

Components 3.2.3.1 9UMEN2506-1200  

User Manual 3.3 9UMEN2518-1200 VMx5 HMI User.pdf” 

Multinet 3.2.3.1 9UMEN2503-1200  

SINUMERIK 
Operate 

1.4.3.4 
Embedding Solution Partner applications in SINUMERIK 
Operate.pdf 

 
 

 


	1. VMx5 HMI package installation
	1.1. Introduction
	1.2. Installation package
	1.3. System requirements
	1.4. Installation
	1.4.1. Installation of the USB-BsLink serial converter driver
	1.4.2. VMx5 HMI installation on a stand-alone PC
	1.4.2.1. Procedure
	1.4.2.2. Folder organization

	1.4.3.  VMx5 HMI Installation on machine control ®Siemens PCU
	1.4.3.1. Procedure
	1.4.3.2. Folder organization
	1.4.3.3.  Integrating VMx5 HMI inside ®Siemens HMI – Sinumerik Advanced
	1.4.3.4. Integrating VMx5 HMI inside ®Siemens HMI sl – Sinumerik Operate

	1.4.4.  VMx5 HMI Installation on machine control ®GE Fanuc PC
	1.4.4.1. Procedure
	1.4.4.2. Folder organization

	1.4.5. Hardware connections


	2. Configuring the VMx5 HMI application
	2.1. Language configuration
	2.2. Connection configuration
	2.2.1. COMx port for rack connection
	2.2.2. IP address for remote operation
	2.2.3. CPU preferences

	2.3. VMx5 system configuration [Devices]
	2.4. Connection and devices recognition

	3. Programming and Setup
	3.1. Introduction
	3.2.  HMI system settings
	3.2.1. Setting the Access Level [Login]
	3.2.1.1.  Login change
	3.2.1.2. Password modification
	3.2.1.3. Restoring the factory password

	3.2.2. Customization of the VMx5 HMI interface layout [Layout]
	3.2.2.1. Viewer settings
	3.2.2.1.1 Custom page generation procedure
	3.2.2.1.1.1 Adding of function cards controls
	3.2.2.1.1.2 Adding of function cards commands
	3.2.2.1.1.3 Label adding
	3.2.2.1.1.4 Panel adding
	3.2.2.1.1.5 Button adding
	3.2.2.1.1.6 Page export and import



	3.2.3. Data recording
	3.2.3.1. Recording commands

	3.2.4. Print
	3.2.5.  Summary of the HMI parameters

	3.3.  Devices software setup
	3.3.1. Parameter modification
	3.3.2. Digital I/O Test

	3.4. Touch detector [type TD]
	3.4.1. Acoustic Emission Variables setup
	3.4.1.1. Introduction
	3.4.1.2. Configuration mode, Variable setup, Sections and Part-Program
	3.4.1.3. Preliminary operation for the system optimization
	3.4.1.4. BASE mode optimization
	3.4.1.5. MULTI-BAND mode optimization

	3.4.2. Power channel setup


	4. Appendix

